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Create your first presentation



Course contents

- A— o ——— —

Overview: Get set with the basics
Lesson 1: Create your slides
Lesson 2: Choose a theme, add more content

Lesson 3: Proof, print, and prep for the show

Each lesson includes a list of suggested tasks and a set of
test questions.
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Overview: Get set with the basics

e -

Have you been asked to put together a
Power Poi nt presentati on,
not sure how to start?

This course will teach you everything
you need to know to create and deliver
a presentation.

Youol | fi nd out how t o ¢cC
content on them, and make them look
good. Then youol l | earn

speaker notes and handouts and get
ready to present.
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Course goals

- S ——————

Create slides and add text.
Insert pictures and other content.
Apply a t heme f
Print handouts and notes.

Prepare to give the show.

or

t

h e

presenit
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Create your slides

— =

This is a glimpse of
the PowerPoint

window.
Click to add title

This lesson will give
you an introduction to
the window and help
you feel comfortable
working there.

Click to add subtitle

Click to add notes

Youol | al so see how to add new sl i1 des,
for a slide, and add text as well as reuse slides from
another presentation.

Finally, youdoll find out how to prepare
create the show, to refer to when you present.
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Get to know your workspace
..
This is the view that
first opens in
- Power Pol nt
Adventure Works k .
sales proposal _-_; Normal view.

Click to add subtitle

You work here to
create slides.

Click to add notes | £ l

EEET e o

There are three main areas of Normal view.

@ Theslide pane is the big area in the middle. You work
directly on the slide in this space.

@® On the slide, the boxes with the dotted borders are
called placeholders. Hereds where you type your
insert art, or add other content.
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Get to know your workspace
..
This is the view that
first opens in
- Power Pol nt
Adventure Works k .
sales proposal _-_; Normal view.

Click to add subtitle

You work here to
create slides.

Click to add notes | £

There are three main areas of Normal view.

® On the left are small, or thumbnail, versions of the
slides in your presentation, with the
on highlighted. This area is the Slides tab.
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Get to know your workspace
..
This is the view that
first opens in
- Power Pol nt
Adventure Works k .
sales proposal _-_; Normal view.

Click to add subtitle

You work here to
create slides.

Click to add notes | £ l

EEET e o

There are three main areas of Normal view.

@ In the bottom area is the notes pane, where you type
the notes that youol | refer to whil e
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Add new slides

When PowerPoint
opens, there
one slide in the show.

You add the other
slides.

Title Slide Title and Content

The most obvious way to add a new slide is by clicking
New Slide on the Home tab, as the picture shows.
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Add new slides

When PowerPoint
opens, there
one slide in the show.

You add the other
slides.

There are two ways to use the New Slide button:

@ I you click the top part of the button, where the slide
icon is, a new slide is immediately added beneath the
slide that 06s Slaglesltab.ct ed on t he
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Add new slides

When PowerPoint
opens, there
one slide in the show.

You add the other
slides.

Title Slide Title and Content

There are two ways to use the New Slide button:

@® If you click the bottom part of the button, you get a
gallery of layouts for the slide. You choose a layout, and
the slide is inserted with that layout.
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Add new slides

If you add a slide
without choosing a
layout, PowerPoint
applies one
automatically.

Title Slide Title and Content

You can change it if you want: Right-click the slide that
has the layout you want to replace, and then point to
Layout.
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Pick layouts for slides

. e A slide layout
Title Slide : Title and arranges your slide
| | content.

For example, you may
want both a list and a
picture on the slide, or
a picture and a
caption.

Layouts contain different types of placeholders and

placeholder arrangements to support whatever your
content is.
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Pick layouts for slides

g (— | The picture shows the
Title Slide | | Teand |a.yOUtS that
cd| PowerPoint starts with
automatically.

ck to add subtitle

@ The Title Slide layout, shown here as it looks in the
layouts gallery, is applied to the first slide in the show
(the one thatos already there when yo

® On the slide, the Title Slide layout contains placeholders
for a title and subtitle.
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Pick layouts for slides

The picture shows the

Title Slide Title and layOUtS that
| PowerPoint starts with
automatically.
ick to add subtitle
® The | ayout youdl l probably use the mo

called Title and Content, shown here as it looks In the
layouts gallery.

@ On the slide, this layout has a placeholder for the slide

title, and a second, all-purpose placeholder that contains
text as well as several icons.
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Type your text

In the all-purpose

Calibri (Body) =~ 3= 1= p|aceh0|der Shown
B I U 8 abe &Y -| |iE & .
e SRNEE = = prewously,_ you can
Fant - DRl : add graphic elements
Current products or text.
(0]

L ettty O------=-=====-=----- o
'+ Qutdoor gear '

— Camping
» Duffle bags
= Backpacks

Let 6s t al k a

— Frame packs
— Day packs

The default formatting for text is a bulleted list.

@ You can use different levels of text within bulleted lists to
make minor points under major points.

® On the Ribbon, use commands in the Font group to
change character formatting, such as font color and size.
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Type your text

In the all-purpose

Calibri (Bady) - 32 = IEEI'_EE_:HE_'HH?' pIaCEhOIder shown
rerrmol e lE previously, you can
Font Parsgraph add graphic elements
Current products or text.
(0]
T Outdoor gear R Letds tal k 3

— Camping
» Duffle bags
= Backpacks

— Frame packs
— Day packs

The default formatting for text is a bulleted list.

® Use commands in the Paragraph group to change
paragraph formatting, such as list formatting, text
indentation, and line spacing.
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Insert slides from another presentation

: Reuse Slides YOU may need tO Use
= Insert slide from: |Ci:Presentations. .. Slldes from an eXIStIng
” ...................................................... — § presentation in your
-l;:f'ic; The me - T:;::::'m . Sh OoWw.

Hereds how t

s . b st

4 [+ Keep source Form atting

@ On the Home tab, click the arrow next to New Slide, as

if you were going to insert a new slide and choose a
layout for it first.

@® Below the layout gallery, click Reuse Slides.
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Insert slides from another presentation

Reuse Slides YOU may need tO Use

Fa

4 | Insert slide from: |} :Present ations. .. Slldes from an eXIStIng
e |— [ W —— § presentation in your

Slide + Reuse Slides

Office Theme - i L . ShOW.

This i1s how to do it.

s . b st

4 [+ Keep source Form atting

® Inthe Reuse Slides task pane, under Insert slide from,
click Browse to find the presentation or slide library that
has the slides you want. Then click the arrow to open
those slides in the task pane.
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Insert slides from another presentation

: Reuse Slides YOU may need tO Use
= Insert slide from: |Ci:Presentations. .. Slldes from an eXIStIng
” ...................................................... — § presentation in your
-l;:f'ic; The me - T:;::::'m . Sh OoWw.

This i1s how to do it.

s . b st

4 [+ Keep source Form atting

@ \When you find the slide you want, take notice of the
Keep source formatting check box at the very bottom
of the pane. If you want to retain the exact look of the
slides youdre I nserting, be sure this
before you insert the slide.
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Insert slides from another presentation

: Reuse Slides YOU may need tO Use
= Insert slide from: |Ci:Presentations. .. Slldes from an eXIStIng
” ...................................................... — § presentation in your
-l;:f'ic; The me - T:;::::'m . Sh OoWw.

This i1s how to do it.

s . b st

4 [+ Keep source Form atting

@ Click each slide you want to insert. Each one is copied
into the open presentation, below the currently selected
sli de or Dbelow your <cur sor, I f youobve
a slide thumbnail.
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Create speaker notes

Use speaker notes to
5 : elaborate on the
e points on a slide.

The Gains

The Opportunity e

Good notes can help
you keep your

» How should we expand our inventory?

* Consider the concept of "“just-in-time” retail. 4 au d | e n Ce e n g ag e d

* Our range will outdo the competition.

. and prevent text

! overload on the slide.

@ As you develop the content on your slides, type your
notes in the notes pane, below the slide.

® You can enlarge the notes pane SO .
work in by dragging the split bar.
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Create speaker notes

Use speaker notes to
5 : elaborate on the
e points on a slide.

The Gains

The Opportunity e

Good notes can help
you keep your

» How should we expand our inventory? . .
= Consider the concept of "just-in-time” retail. ' £ : au d lence en g ag e d

* Our range will outdo the competition.

— and prevent text

! overload on the slide.

® Your notes are saved in a notes page, which contains a
copy of the slide along with the notes. This is the page
you print to refer to as you give the presentation.
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Suggestions for practice

Get familiar with the areas of the PowerPoint window.

Type text.

Add new slides.

Navigate and add more text.
Use text indents and formatting.
Work with text automatic text fit.

Type and view notes.
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content




Choose a theme, add more content

As a color scheme for
your presentation,

Adventure Works Adventure Works basic black will do the
2008 Sales Proposal 2008 Sales Proposal JOb

LINDA MARTIN
SENIOR VICE FRESIDENT

i But how about when
youore 1 n th
more color and a

vibrant design?

Go straight to the PowerPoint themes gallery and try
out whatos there. Choosing a theme 1 s r
flipping a switch.

You can also put other elements on your slides, such
as pictures and captions, then handily align them so
that everything is neatly arranged.
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The beauty of themes

Adventure Works 2008 Sales
Proposal

Adventure Works
2008 Sales Proposal

Linicds Martan
Sarnzoe Vatw Prewdens
W bdwidle Sales

Every presentation
has a theme.

Some are just more
colorful than others.

The theme determines the look and colors of your slides
and gives your presentation a consistent appearance.

Here, you see three title slides that have the same
content but that use different themes.
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The beauty of themes

—

Every presentation
has a theme.

Adventure Works 2008 Sales
Proposal

Some are just more
colorful than others.

Adventure Works
2008 Sales Proposal

Linicds Martan
Sarnzoe Vatw Prewdens
W bdwidle Sales

A theme includes these elements, offered as a package:

A Background design
A Color scheme
A Font types and sizes

A Placeholder positions
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The beauty of themes

The color scheme
affects background
adventure vorks 2008 saies RN colors, font colors, fill
b colors for shapes,
border colors,

2008 Sales Proposal | hyperlinks, and slide

S Vi Breni B elements like tables
and charts.

Adventure Works

And if you have placeholders, the theme honors the
| ayout youbve chosen,; It jJjust moves t hi
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Choose a theme

Every new
presentation starts out
with the default theme,
called Office Theme.

Adventure Works To fmd and apply
2008 Sales Proposal another one, start by
clicking the Design
S onr e sapee tab on the Ribbon.

@ Theme samples, in the form of the small thumbnails you
see here, will show in the Themes group.

® To see additional themes, click the More button on the
right of the group.
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Choose a theme

Every new
presentation starts out
with the default theme,
called Office Theme.

Adventure Works To find and apply
2008 Sales Proposal another one, start by
clicking the Design

SENIOR VICE PRESIDENT

WORLDWIDE SALES tab On the Ribbon.

® \When you point to any theme thumbnail, a preview of it
Is shown on the slide.

Click a thumbnail to apply that theme to all your slides.

You can also apply the theme only to the slides you
have selected.
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Insert pictures and things, part 1

Now youol | |
methods for inserting
pictures and other
non-text items into
slides.

The first method is to click an icon in a placeholder,
which you got a glimpse of in the first lesson.
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Insert pictures and things, part 1

Now youol | |
methods for inserting
pictures and other
non-text items into
slides.

The picture illustrates how to insert a piece of clip art:

@ Click the Clip Art icon in the placeholder.

@® The Clip Art task pane opens. There, type a keyword in
the Search for box that suggests the sort of clip you

want. Then click Go.
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Insert pictures and things, part 1

Now youol | |
methods for inserting
pictures and other
non-text items into
slides.

The picture illustrates how to insert a piece of clip art:

® Clips appear that fit the keyword. Click one of them to
insert it into the slide. The picture is automatically sized
and positioned within the placeholder.
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Insert pictures and things, part 2

Home Insert Design .E-r'uirnaﬁ'r'u' Slide Show F.:'--'ia-.-- View Format AnOther Way to Insert
J el E";!,- [y Shapes = &, Hyperlink - _‘|Hr-uj.=| L Footer |#] Slide Number Slide itemS iS to use
i | T SmartArt i, Action fordart - L2 symbaol

raure Qp poto o 1 Eﬁa o omearme oo th_e Insert tab on the
INustrations Links ext Rlbbon_
A_I

All of the things you could insert from the slide pane are
also available on the Insert tab, plus mored including

shapes, hyperlinks, text boxes, headers and footers, and
media clips such as sounds.
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Insert pictures and things, part 2

Home Insert Design Animatio r| Slide Sho F.:--ia-.-- View Format The pICture ShOWS the
J g m } Shapes - & Hyperlink - _'| Header & Footer |#] Slide Number array Of thlngs
e e sram available on the Insert

riaure SE Abu - il Char 1) B 3 1 Date &Time '3l Object
ustrations Links i ext tab.
A_I
== A typical thing to insert
IS a text box, as

shown.

@ Text boxes are handy when you want to add text
somewhere and need another placeholder for it, such as
for a picture caption. On the Insert tab, click Text Box.

@® Draw the box on the slide and type in it.
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Insert pictures and things, part 2

Home | Insert | Design -1'-r|irna+i'r'|' Slide Show F.:'--'ian---' View Format What 0s t he b
J ElE E:;} } Shapes = @, Hyperlink - _‘|Hr-dj.=| . Footer [#] Slide Number method?
a [III_|;.I|}'_-::.ir-I:1I|::'- e Links N et - Since you have two
j—l _. choices for how to
Happycampa: I insert some things,
which one is

recommended?

It mostly comes down to what you find handiest. One
thing to consider is how you want the inserted item to be
positioned on the slide.
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Edit slide elements

I " l After inserting a
! 3 .
Animations Slide Show Review View | Format = plcture, you may Want
) — L_lj‘ Ficture Shape - 3 Bring to Front = |2 Align ~ ] | e I
‘d‘ ‘d‘ ‘ x E Picture Border - Lﬂjﬁend to Back - E-Er-:n.u:- -~ o to make adJUStmentS
T ) Picture Effects ~ 1, Selection Pane [ Rotate ~ SO SUCh as reSIZlng,
Picture Styles n Arrange oz Cropplng, (0]§ Changlng

the brightness.

Use Picture Tools for
this.

Picture Tools are available when the picture Is selected.

@ So, select the picture.

@® Picture Tools appear above the Ribbon. Use options on
the Format tab to work with the picture.
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Edit slide elements

R " l There are tools for the
Animations  Slide Show  Review  View I| Format 2 range of thlngS you
s = lb Il sl =Tl can insert, from
i U Ll e S 0 ci\2is, anc
Bichue, Shes =l SmartArtE graphics to
text boxes and
shapes, sounds, and

videos.

Just select the inserted item to see the relevant tab on
the Ribbon.
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Arrange slide elements

.F'ictureTc-culsl . O n C e y O u 6 V e
"4, Bring to Front - m— Want On the Sllde, you

3% Send to Back ~ | |2 Align Left [ 3
.

ﬁ:;ﬁel;ctic-n Fane | & | Align Center need tO allgn them SO
iy =1 | Alion Bight they look just right.

If  Align Top

Align Middle

Align Bottom

For example, in this picture, the text box with the caption
wi | | | ook best once 1to6® aligned evenly
either flush left, or correctly centered.
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Arrange slide elements

pcture Tool - You use the Arrange

v - commands to align
b = IR TIR i olements,

3% Send to Back ~ | |2 Align Left [ 3
ﬁ, Selection Pane | &  Align Center

:-_" Arrange =S| Align Right

If  Align Top

Align Middle

Align Bottom

@ 70 align the caption so ités flush | e
select both placeholders.

® In Picture Tools, find the Arrange group on the Format
tab.

® Click the Align button, and then click Align Left.
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Suggestions for practice

- S ——————

Choose a new theme.

Insert a picture.

Resize the picture.

Add a caption.

Align the picture and caption.

Bonus: Add an animation effect.
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Proof, print, and preg




Proof, print, and prep for the show

Youove | earn
essentials for creating
a slide show.

Now imagine that your
presentation is ready,
and you want to
prepare to present it.

Youol!l | need to preview 11, run a spel |
from others, and check your handouts and notes
before printing them.

Then you can use the PowerPoint packaging feature
to place your presentation on a CD or on the computer
youoll use to present .
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Preview on your computer

Insert Dresign Animations 5lide Show Review View AS you Crea’te a' ShOW’
-:E —Q j—r L 3 k5 Record Marration ] |i:.e5r:||uti y0U Can DFEVIGW It a.t
moml) fom | custom Sull any time in Slide

Beginning Current Slide ' Slide Show ~ gs Use Pres

[ start stide show ) Adv Show view.

This view gives you an
Idea of how the slides
will look and behave
when projected.

@ 1o open Slide Show view, click the Slide Show tab, and
click a command in the Start Slide Show groupd to
start on the first slide or current slide.

@® Slide Show view fills your computer screen.
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Preview on your computer

Insert Dresign Animations 5lide Show Review View AS you Crea’te a' ShOW’
-:E —Q j—r L 3 k5 Record Marration ] |i:.e5r:||uti y0U Can DFEVIGW It a.t
moml) fom | custom Sull any time in Slide

Beginning Current Slide ' Slide Show ~ gs Use Pres

[4: Start Slide Show ) Show view.

This view gives you an
Idea of how the slides
will look and behave
when projected.

® One way to navigate from slide to slide is to use the
Slide Show toolbar, at the bottom-left of the screen.

@ To get out of Slide Show view at any point, press ESC.

This returns you to the view you left, which is typically
Normal view.
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Preview on your computer

—

Here are some other ways to open Slide Show view:

APress F5 to start on the first slide.
APress SHIFT+F5 to start on the current slide.

AClick the Slide Show button in the lower-right portion of the
PowerPoint window, next to the Zoom slider.

When you do this, the show begins
selected on the Slides tab.

AClick the Slide Show button on the View tab. The show begins on
the first slide no matter which slide is currently selected.
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Check spelling, send for comments

o € o ‘ > 7 Before you present,
g2 -07" youdl |l want

Home Insert Review 5lide Show Review View Format .
— | ——— out spelling errors and
. . ] = o d !
= 4 24040 find any other goofs

Spelling| Research Thesaurus Tr Edit Dé W Edit  Delete Previous Mext
) Comment Co Comment -~
Comments ) 5 and gapS.

Spelling

Mancy, you need to add

Mot in Dickionary . ko the lisk For camping pr

Suggestions:

Change

Go to the Review tab on the Ribbon to run a spelling
check.

The Review tab is also where others can go to add
comments as they review your slides.
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Check spelling, send for comments

~— o ‘ > 7 Before you present,
(On) 9 -0 77

3 . youol !l want

Home Review 5lide Show Review WView Format .
\ ] : A ¥ 717 out spelling errors and
Spelling| Research Thesaurus Tr E-:Ii; D W Edit  Delete Previous MNet flnd any Other gOOfS

Comment Co Comment  ~

."D:nmments Lo 5 and gaps'

Spelling

Mancy, you need to add

Mot in Dickionary . ko the lisk For camping pr

Suggestions:

Change

Once vy ouo0Reeewotab, do ds éhe picture
shows:

@ In the Proofing group, click Spelling, and make

selections as the spelling checker moves through your
slides.
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Check spelling, send for comments

~— o ‘ > 7 Before you present,
(On) 9 -0 77

3 youol !l want

Home Insert Review 5lide Show Review Wiew Format .
\ ] : A ¥ 717 out spelling errors and
Spelling| Research Thesaurus Tr E-:Ii.t D W Edit  Delete Previous MNet flnd any Other gOOfS

Comment Co Comment  ~

."D:nmments Lo 5 and gaps'

Spelling

Mak in Dickionary:

Suggestions:

Change

Once vy ouo0Reeewotab, do ds éhe picture
shows:

@® You might also want to have others review the
presentation and make comments before you present.
Youo !l | Néew CGohmenhcemmand in the
Comments group, also on the Review tab.
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Print handouts

—_— | ‘ The most common

@ - Print What: 1 F:I ':{ “ _ﬁ. Mext Page type Of PowerPOInt
Print Options || Handouts 3 |T| Orientation || Zoom  Fit to _ip Previous Page | Close Print prlntOUt fOr aUdlenCeS

il S Window Preview

Print Sl Zoom Preview |S Ca"ed a handOUt

Handouts (1 Slide Per Page]
Handouts [2 Slides Per Page]

Handouts (3 Slides Per Page] [

Handouts (4 Slides Per Page) 8

—_— Handouts can have
Handouts (& Slides Per Page) o S . .
Handouts (9 Slides Per Page] o S — One Or Several SlldeS

MNotes Pages

s | per page, up to nine.

A good practice is to use Print Preview to select the
handout type you want, as shown here. That way you
can see how the handout will look before printing.
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Print handouts

— To print handouts,

@ - Print What: 1 F:I ':{ “ jNe:u:t Fage Start by CIICkIng Prlnt
Print  Options || Handouts 3 |T| Orientation || Zoom  Fitto _ip Previous Page | Close Print Pr9V|eW on the menu

il S Window Preview

Print Slides Zoom Preview that Opens When yOU

Handouts (1 Slide Per Page]

Handouts 2 Sldes Per Page click the Microsoft
andouts |.:= Shides Per 'El:_]E.I i . / o
| Office Button &.

Handouts (4 Slides Per Page) 8

Handowts (6 Slides Per Page)
Handowts (9 Slides Per Page)

MNotes Pages B — Then fO”OW the StepS
Outline View I I
shown in the picture.

@ InPrint Preview, click the arrow in the Print What box
to display the list of handout types.

® Choose the handout type you want.
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Print handouts

—_—— | ‘ To print handouts,

@ - Print What: 1 F:I ':{ “ jNe:u:t Fage Start by CIICkIng Prlnt
Print  Options || Handouts 3 |T| Orientation || Zoom  Fitto _ip Previous Page | Close Print Pr9V|eW on the menu

il S Window Preview

Print Slides Zoom Preview that Opens When yOU

Handouts (1 Slide Per Page]

Handouts 2 Sldes Per Page click the Microsoft
andouts |.:= Shides Per 'El:_]E.I i . / o
| Office Button &.

Handouts (4 Slides Per Page) 8

Handowts (6 Slides Per Page)
Handowts (9 Slides Per Page)

MNotes Pages B — Then fO”OW the StepS
Outline View I I
- shown in the picture.

® When you click the handout type, youb
preview of how your slides will look when printed in that
format. You can navigate through all the handout pages.
The handout type with the 3 slides per page option also
includes lines for audience notes.

When youobdre reaPdipt.t to print, click
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Print speaker notes

Youobve

Print Preview p r I n t
@ Print What: f::l ';,; “ _§ Next Page handOUtS_ to give to
Print l:]ptinns Handouts 3 ... Crientation Zoam -...fit;ﬂ _}F'r-:-.:i-:n.l-:- Page I:ZIFclusv.e_F'rint yOur aUdlence.
Print Slides 8 ‘ Preview ‘
Handowuts (1 Slide Per Page] .
:angnu: :_ J:Ije Eer Eageg: Now print Speaker
Handouts IE-'l Slides Per F'E!;IEEI notes fOI’ yourself,
Handouts [& Slides Per Page] .
Handouts @ Slides Per Page] 1 WhICh yOU Can refer tO
Motes Pages
e View s as you present.
| t6s a good practice to ook at your s
you pr i N TSERCR O see | they | ook as
them to.
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Print speaker notes

Print Previaw

s34 k|| Print What:

Print Options ||| Handouts 3 ..

Print Slides
Handowuts (1 5
Handowuts (2 5
Handowuts 3 5
Handowuts (4 5
Handowuts (6
Handowuts (9

Motes Pages

QOutline View

Orientation

lide Per Page)
lides Per Page)
lides Per Page)
lides Per Page)

Slides Per Page)
Slides Per Page)

[% L

I;‘_{ “ _ﬁ. Mext Page

Zoom Fit to
Window
Zoom

_} Previous Page

Preview

Close Print
Preview

To print speaker
notes, click the
Microsoft Office
Button, point to Print,
and then click Print
Preview.

Then follow the steps
shown in the picture.

@ Sclect Notes Pages in the Print What list.

@® Your notes pages are shown in the preview window,

starting with the first slide (unless you specify otherwise).
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Print speaker notes

Print Previaw

s34 k|| Print What:

Print Options ||| Handouts 3 ..
Print AN
Handowuts [1 5
Handowuts (2 5
Handowuts 3 5
Handowuts (4 5
Handouts (6
Handouts (9
Motes Pages
Outline View

Orientation

lide Per Page)
lides Per Page)
lides Per Page)
lides Per Page)

Slides Per Page)

Slides Per Page)

[% L

I"*—qi “ _ﬁ. Mext Page
Zoom  Fit to _ip Previous Page

Window
Zoom Preview

Close Print
Preview

To print speaker
notes, click the
Microsoft Office
Button, point to Print,
and then click Print
Preview.

Then follow the steps
shown in the picture.

| f S 0Omet

After wvyo
print, click Print.

hing

uobdve

il snot formatted as youod i
text has been cut off, make the necessary adjustments
either in Notes Page view or in Normal view.

checked

your

notes and yol
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Add footer text to handouts and notes

Print Preview also
@ _...._ 1 Print What: E Slide  Motes and Handouts | aﬁords you the Ch ance
Print Dpt‘irnns Handouts (3 ... = || Crientation Include on page to add or adJUSt
Fil O]  Header and Footer... r E—'_afE' and Lime foote s |n your
B Color/Grayscale handouts and notes.

Print Preview

¥ Page number

By default, printed handouts and notes have page
numbers.

But they can show other things, such as footer text.
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Add footer text to handouts and notes

Print Preview : A FO"OW these StepS |f

[l e wna PO o | et i | you want your

Print Dpt‘ircuns Handouts 3 ... - | Orientation Include on page prlntOUtS tO ShOW
P 0) Hescerand Foster. 1 S ol other content.

E Color/Grayscale

¥ Page number

IV Foater| Confidentiall | 2

@ Click Options, and then click Header and Footer.

® To show footer text, such as fADrafto
select the Footer option, and then type the text you want
in the box.
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Add footer text to handouts and notes

Print Preview » A FO"OW these StepS |f
@ __ L Print What: Ijiil glide  Motes and Handouts | you Want your
Print Dpt‘ircuns Handouts 3 ... - | Orientation Include on page prlntOUtS tO ShOW
P Header and Footern. S ol other content.

E Color/Grayscale

¥ Page number

¥ Footer| Corfidentiall E

The selections you make on the Notes and Handouts
tab in the Header and Footer dialog box apply to your
handouts and your notes pages.
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Color options for printing

Depending on what

ki nd of prin
using, you can print

your presentation in
Color, Grayscale, or

Pure Black and White.

Herebs how to select an optiron for prin

@ Under Print Preview, click Options, and point to
Color/Grayscale. Then select from the menu. Your
slides will be previewed and printed with that choice

applied.
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